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Overview

This article walks through the steps to record matching contributions in Trail Blazer. The process entails:
- Setting up a company/organization record as a ‘matching donor’ (along with the percentage that they’re willing to match)

- Entering the original gift and flagging it as needing a match (or multiple matches)

- Viewing a report of unfulfilled matching gifts

- Recording the matching gifts as they come in

¢« Tip: Use the Ctrl+F hot key to jump to different sections of this article (example: “#1”, “#2” or “Related Resources”. Also, click here to watch a
video on this topic.

Outline
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#1 Setup a Company/Organization as a Matching Donor & Enter the Percentage they’re willing to Match
#2 Recording a Donation and Flagging it as needing a Matching Gift

#3 Viewing a Report of Unfulfilled Matching Gifts & Recording them as they come in

#4 Related Resources

#1 — Setup a Company/Organization as a Matching Donor & Enter the Percentage

they’re willing to Match

Navigate to the Contacts (Donors/Voters) list and run a search query for the company/organization you want to setup as a matching donor, and
open their record.
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2. Build and run your search query for the company/organization you want
to setup as a matching donor.

a Settings  Help

Application Menu <<I‘:?3!Search k Reset | <k New =i R=a File - Edit ~ | ) S Include Other | Contacts

Favortes | Genersl | Address | Household | Attribute | Canvass | Relation | Contribute | Fledge | Event | Sales | Log | Admin | sQL |

B Dashboard

> G Organization Name | Phone | E-Mail | Email Links | Profile | Work | Demographics | User, Text | User, Dates | User, Decimal | Other |

i § Calendar/Tasks Q

» B canvassing 1 !
Contact ] Individual Last Name: -

’ %Eﬁnl:ontacts / e ] e Search all name parts

@ fad Corporation First'Org Mame: Hormel Foods *  (amywhere in field) Suffix:
resses

@ Households Foundation Middle Name: T

EE| Contact Relationships

|- “#p Contributions/Pledges Prior Last Name:

5 % Product Sales
b > Logs

i+ 5 Communications
[» a Financial

[ % System Manager

Mickname:

S8 Edit | Sort B Format ~ 53 Wrap | 8% Export < Print Summary []] = | & Pivot .

Contacts [ 1 records found ]

. . Zip
First Mame Street Street 2 City State Code

|u 15304 ” Hormel Foods “ 6500 City W Plowy #102 Eden Prairie MM 55344 I [952) 931-1220
i kR 1 1 [ 1 [

Bus Phone

3. Click on the name hyperlink to open their cnntact record.
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Navigate to the General > Other tab, check the box for ‘This organization (or individual) has agreed to match contributions received from others’,
and enter the percentage they’re willing to match. Click [Save and Close] once you’re finished.
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File - Edit ~ | | 0 | [d) & | “ & | Hormel Foods [15304]

Title: - Home Address e
Organmization Hormel Foods Hﬂrmel No Add

o ress
Middle (opt)

Last Name (opt)

-

Frior Last Mame: Email

m

(ont) info@hormel-foods.com Work Address
Nickname (opt) g% City W/ Plowny |-
Contact Type: [Cnlpnlatiun ,] Eden Prairie. MM 55344

General .ﬁousehnldlﬁaﬂerylﬁﬂribdel Pol | Relation | Contribute | Pledge | Evert | Logs | Sales | Admin |

| Address | Contact | Profile | Work | User |Mmbem;i| Other I

This organization (or individual) has agreed to match contributions received from others.
Maich Percentage: ; 100

1 \

2
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Repeat these steps for all donors who are willing to provide a matching gift. The next section shows how to record the original donation and flag it
as needing a matching gift.

#2 — Recording a Donation and Flagging it as needing a Matching Gift

Navigate to the Contacts (Donors/Voters) list, run a search for the donor who provided the original donation, and open their record.
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2 - run a search for the donor who provided the original donation.

&) Settings
Application Menu « Reset | dF MNew (=l = W] File » Edit ~ | ) | §gInclude Other | Contacts
El= @ 0
Tasks
» O Dashboara || Rvertes)is O
G Organization # Name | Phone | E-Mail | Email Links | Profile | Work | Demographics | User, Text | User, Dates | User, Decimal [ Other |
> § Ccalendar/Tasks Q

> % Canvassing
4 B contact Individual Last Name: Smith - Title:

[EH Contacts <— 1 [ Corporation First/Org Name: Bob - E‘;aamrncpheharl‘la?ra.rﬁn;g]arts Suffix: .

@ Addresses .
) Middle Name: -
@ Households Foundation —

@3 Contact Relationships
> 4 Contributions/Pledges Prior Last Name:
b % Product Sales
[ QV> Logs
> % Communications
i (il Finandial
[ % System Manager

Help

Mickname:

=8 Edi - 53 Ny i i =l Pi
S8 Edit | Sort ) Format -~ 53 Wrap | &% Export & Print Summary [ = |[E] Pivot .

jin] Last Mame =~ First Name Street Ci State Zip Home Phone Email Employer/Company Mame
Code

I Smith Bob ” 4440 Thomas fve 5 I Minneapolis MN 55410 [231) 564 -7897 ” bob-smith-23@hormel-foods.com Hormel Foods

3 - open their record to record the original donation.

Navigate to the Contribute tab and click [+ New].
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File ~ Edit = | 3 | @ | [d] & | @ 8 | Bob Smith [14622]

Title: - - Home Address
First Name Bob 7 -i-MD ThD”'_'aﬁ A 5
Minneapolis, MM 55410
Middle Name 231-564-7857
No Photo
Last Name/Suffix Smith
i . Work Add
Prior Last Name bob-smith-23@hormel- reAddress
Nickname foods.com
Mo Address
Contact Type: [‘ i v]
| General | Household | Gallery | Attibute | Poll | Relatior| Contribute | Event [ Logs | Sales [ Admin |
= - .
BB New [ Refresh | Sort B Format ~ 53 Wrap Export & Print | B Pivot |
Contributions [9 records found]
Amount De-  Applied Allocated Memarial/ Memaorial/
Open (o) Date Amount Refunds After Cycle et Event (R pos-  Against L Matc_hes to Specific  Honorarium Honararium
jing Method : Expected Received
Refunds ited Pledges Funds Type Person
/ E 4,510.00 .00 4,510.00 | Calendar Year 2015 Check .00 .00 .00 .00
Open 11/2/2015 50.00 00 50.00 | Calendar Year 2015 Check .00 .00 .00 .00
Open 46436 11/1/2015 50.00 .00 50.00 | Calendar Year 2015 Check 00 00 00 00
Open 45563 9/18/2015 50.00 00 50.00 | Calendar Year 2015 Check 00 00 00 00
Open 45439 9/1/2015 50.00 .00 50.00 | Calendar Year 2015 Check 00 00 00 00
Open 45403 8/28/2015 500.00 00 500.00 | Calendar Year 2015 Check 00 00 00 00
Open 45157 7/27/2015 50.00 00 50.00 | Calendar Year 2015 Credit Card 00 00 00 00
Open 44187 4/12/2015 50.00 00 50.00 | Calendar Year 2015 52 Theater Event - Come to the Show! Check .00 .00 00 00
Open 43543 3/20/2015 15.00 00 15.00 | Calendar Year 2015 Check 00 00 00 00
Al s 5,325.00 00 5,325.00 00 00 00 00

Fill out the contribution form under the General tab, and click [Save] (make sure to keep this form open for the next step).
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Fill out the donation form under the General tab and click [Save].

) Contribution

File » Edit = | D¢ | &

Bob Smith

A440 Thomeas fwe S Less Refunds:
Minneapolis, MM, 55410 MNet Amount:

Fefund I Allocate | Match | MemoryHonar | Motify | Cther | Gateway|

Bvent; [Zl}lﬁ - Pledge Drive - Direct Mail (LU5P5)
Cycle: [ Calendar Year 2016

Date Received: 12/ 5/2016 &

Type: [ Check - ]

Recurrence: [ single - ]
Check Number 1245
Amount; 50.00 Tax Deduct Amt: 50,00

Mema:

o Save and Close | [ (@) Cancel ]
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Navigate to the Match tab and click [+ New].
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@m_ =

File » Edit - | 3 | @ |

Bob Smith Amount: 50.00
o Ave © Less Refunds: 00
Minneapolis, MN, 55410 Net Amount: 50.00

General | Refund Match /Honor | Notify | Other | Gateway |

&S New | Sort ) Format » =3 Wrap | &% Export ‘& Print | Pivot I

0 record

Last First Amount  Amount
LEE Mame Mame = Expected Received
0 .00 .00

) Ssve | |#SsveandClose | |(@Cancel | [lw.trailblz.com/kb 11
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Select the matching donor from the drop-down list (covered in section No1) and click [OK]. You can adjust the matching amount if necessary.
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E

Q Contributicn
File ~ Edit ~ | | i@ |

Bob Smith Amount;

50,00
4440 Thomas Ave S tesckmnc | )
Minneapolis, MM, 55410 MNet Amount: 50.00

| General | Refund | Allocate | Match | Memory/Honor | Notfy | Other | Gateway |
&l New |[E Sort B Format ~ S3Wrap | &% Export ¢ Print | [ Pivot |
Matching Contributions [0 records found]

Match Organization: | [Hurmel Foods
Amount Expected: 50.00

Select the matching
donor.

e Save | |gfSaveandClose | [@cCancel ]
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Repeat this step until all the expected matching gifts have been recorded, and then click [OK].
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.

File -~ Edit - | ) | @ |

Bob Smith

4440 Thomas Ave S
Minneapohs, MM, 55410

| General | Refund | Allocate | Match | Memory/Honor | Notify | Other | Gateway |
&8 New | Sort ) Format ~ 53 Wrap | % Export <2 Print | ) Pivot |
Matching Contributions [0 records found]

Amount Amount
Expected Received

Hardware Hank
United Way

o Save and Close | | lww.trailblz.com/kb 15
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Click [Refresh] and the data will update in the donor’s record. There’s a column that will display how much (in total) is expected to be matched.
You may need to widen out the column dividers in order to view this if it isn’t showing by default.
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File - Edit ~ | 3 | @ = | @ &t | Bob Smith [14622]
Title: - Ve Home Address
First Name Bob 4440 Thomas fve S . .
( Minneapolis, MN 55410
e Name Minneapols. This column will reflect how
No Photo . .
Last Name/Sufic Smith W much money (in total) is expected
i
Prior Last Mame 3 Work Address - . .
bob-smith-23@hormel-
S bob-smith- to come in as matching gifts.
Mo Address
Contact Type: | Individual - \
| General | Household | Gallery | Attribute | Poll | Relation | Contribute | Pledge | Event | Logs | Sales | Admin | \
- == D . .
ER New | [ Refresh |FER Sort ) Format - 53 Wrap | % Export 2% Print | ) Pivot .
Contr* . dons [10 records found]
Amount De-  Applied
Event Payment ) Matches Matches
Open i Date Amount Refunds After Cycle o Event M:thc-d pos- Against Expected Received
Refunds ited Pledges
Open 46903 | 12/5/2016 50.00 .00 50.00 | Calendar Year 2016 | 57 2016 - Pledqe Drive - Direct Mail (USPS) | Check .00 200.00 00|
Cpen 40463 11/3/2015 4,510.00 00 4,510.00 | Calendar Year 2015 Check 00 00 00
Cpen 46446 11/2/2015 50.00 00 50,00 | Calendar Year 2015 Check 00 00 00
Cpen 46436 11/1/2015 50.00 00 50,00 | Calendar Year 2015 Check 00 00 00
Open 45563 9/15/2015 50.00 00 50,00 | Calendar Year 2015 Check 00 00 00
Open 45439 9/1/2015 50.00 00 50,00 | Calendar Year 2015 Check 00 00 A0
Open 45403 8/25/2015 500.00 00 500.00 | Calendar Year 2015 Check 00 00 00
Open 45187 7/27/2015 50.00 00 50,00 | Calendar Year 2015 Credit Card .00 .00 .00
Open 44137 4/12/2015 50.00 .00 50.00 | Calendar Year 2015 52 Theater Event - Come to the Show! Check .00 .00 .00
Open 438458 3/20/2015 15.00 .00 15.00 | Calendar Year 2015 Check .00 .00 00
E] 10 5.375.00 00 5.375.00 00 200.00 .00

The next section covers the final steps of viewing un-paid matching gifts, and how to record the gifts as they come in.
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#3 — Viewing a Report of Unfulfilled Matching Gifts & Recording them as they come in

Under the Application Menu navigate to the Contribution Matches list.
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£) Settings Help
Application Menu “

f Dashboard
I % Organization
» & Calendar/Tasks
[ % Canvassing
4 % Contact
Contacts
@j Addresses
@j Households
Contact Relationships
4 "B Contributions/Pledges
@ Contributions

@ Contribution Allocations

@ Contribution Matches ‘—
@ Contribution Motifications
B Fledges
EJ Pledges, Detail
[=4 Thank You Letter - Contributions
> [4] Reports
5 (. Product Sales
[ @ Logs
i+ 7% Communications
[» a Financial
[» % System Manager
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Click [Search] to populate all unpaid matching gifts. In my example | had 74 and | sorted by the ID in descending order to put the most recent ones
at the top.
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l G Search

| Favortes | Genersl | [Match] Contact | Contribution | SQL |

Reset | <= New o |l B File - Edit - | ) | Contribution Match List

9

Amount Expected:
Unpaid

minimum * to maximum -

This box will be checked by default.

\

You can sort in descending order to put the most recent entries at the top.

Sk Edit | Yort B Format - S3Wrap | &% Export ¢ Print | B Pivot |

[Match] Donor

Contribution

Amount

Amount

Donar Last

Donor First

B 5 Last Name [MatchiiDonogbisEName Date Expected Received Mame Mame
N =

97 Hardware Hank 12/5/2016 50,00 00 || Smith Bob

96 Hormel Foods 12/5/2016 50.00 00 || Smith EBob

a5 Caraill 8/7/2015 90.00 00 || Zwack James

a4 Corporation for Mational And Community Service 6/7/2012 695,00 00 || Burton lane

92 Hardware Hank 6/4/2012 200.00 00 || walters Judy

a0 Corporation for Mational And Community Service 5/21,/2012 550.21 00 || Culloton Matthew

89 United Way 5/17/2012 65000 00 || Hemshrot Mary

88 Welcome Trust 5/14,2012 400.00 00 || Eisenberg EBenjamin

a7 United Way 5/3/2012 1,000.00 00 || Hemshrot Mary

36 Hardware Hank 5/2/2012 75.00 00 || Wambach Dorene

a5 Corporation for Mational And Community Service 5/2/2012 500.00 00 || Addington Eric Jay

a3 Cargill 411/2012 1,400.00 00 || Boy Carmen

52 Corporation for Mational And Community Service 4/9/2012 500,00 00 || Hockaday James

&1 Cargill 4/5/2012 19.98 00 || Latsch Michael

&0 Corporation for Mational And Community Service 3/30/2012 350.00 00 || Meier David

79 Cargill 3/28/2012 300.00 00 || Gibson James
11 78 Corporation for Mational And Community Service 3/26/2012 1.,100.00 00 || Kelly William
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Here you can view all the details such as the amount expected and amount received.

When a donation comes in from a matching donor, click on the donors name hyperlink to open their record. In my example | used Hormel Foods.
This step is VERY important, the ‘amount received’ for a matching gift will *not* update unless you record the donation from the matching

donor.
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Q

| Faverites | Genersl | [Match] Contact | Contribution | SQL |

! L - - o . " . "
<52 Search %, Reset | <= New 10 | EH ¥ @ File ~ Edit L7 ContnbutmnMa’tcthtl

)

Amount Expected:
Unpaid

minimum w to maximum -

S8 Edit | Sort B Format » S3Wrap | B Export & Print | B Pivot |
Contribution Match List [ 74 records found ]

Matching gift details.

D e Name . [Match] Donor Frst Name bate " Eapedted Receved R Name
93 United Way 12/5/2016 100,00 smith
Hardware Hank 12/5/2016 50.00 00 || smith Bob
[Z Hormel Foods 12/5/2016 50.00 [ Smith 30

95 Caraill 8/7/2015 90.00 00 || Zwack James
94 / Corporation for Mational And Community Service 0,/7/2012 895,00 .00 || Burton Jane
92 / Hardware Hank B,/4/2012 200.00 .00 || Walters Jud
90 Corporation for National And Community Service 5/21/2012 550.21 .00 || Culloton Matthew
89 United Way 5/17/2012 650,00 .00 || Hemshraot Mary
88 Welcome Trust 5/14/2012 400.00 .00 || Eisenberg Eenjamin
a7 United Way 5/3/2012 1,000.00 .00 || Hemshrot Mary
36 Hardware Hank 5/2/2012 75.00 .00 || Wambach Dorene
85 Corporation for National And Community Service 5/2/2012 500.00 .00 || Addington Eric Jay
a3 Cargill 4111/2012 1,400.00 .00 || Boy Carmen
82 Corporation for National And Community Service 4,/9/2012 500.00 .00 || Hockaday James
a1 Cargill 4/5/2012 19.95 .00 || Latsch Michael
80 Corporation for National And Community Service 3/30,2012 350.00 .00 || Meier David
I Cargill 3/28/2012 300.00 .00 || Gibson James

11 78 Corpaoration for National And Community Service 3/26,/2012 1.100.00 00 || Kelly William
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Navigate to the Contribute tab and click [+ New].

File - Edit » | 3 | @ & | 0 8 | Hormel Foods [15304]

Title: . Home Address
Organization Hormel Foods Horme’ S~

\ o Address
Middle (opt) -

- el

Email
Friar Last Name
[nt) TR T M e WDrkAd.l:lrm
Nickname (opt) g% City W/ Plowy
Contact Type: ’Culpuratiun v] Eden Prairie. MN 55344

| Gallery | Attribute | Pol | Relation | Contribute | Pledge | Event | Logs | Sales | Admin |
Bl New |2 Refresh | Sort ) Format - 53 Wrap | 5% Export & Print | fEF) Pivot .

Amaount De-  Applied Allocated Memarial/ Memarial/
pen (o] Date  Amount Refunds After Cycle EVERE Event Rayment pos-  Against Batenes Matc_hes to Specific  Honorarium Hanararium
) (n] Method : Expected Received
Refunds ited Pledges Funds Type Persan
= 00 00 00 0 00 .00 00 00

Fill out the donation form and then [Save and Close]. /t’s not a bad idea to record a note that the gift is for a matching contribution, my example is
below.
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) Contribution

File ~ Edit = | 3 |

Hormel Foods Amount:
Less Refunds:

Net Amount:

efund | Alocate I Match | Memoary Honaor | Motify I Cther | Eatewa}r|

[?_l}lﬁ - Pledge Drive - Direct Mail (USPS)

| Calendar Year 2016

Date Received:  12/20/2016 El~
Type: [ Check hd ]

Recurrence:
Check Mumber
Amount:

Memao:

Fill out the donation form.

[Singie v]

4545

50,00 Tax Deduct Amt: 50,00
Matching gift for Bob Smith's donation on 12/5

| Save and Close | i@{:ame| ]

ww.trailblz.com/kb
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Close out of the matching donor’s record and return back to the Contribution Matches list.
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e Settings  Help

Application Menu || File - Edit - | | @ | [d) & | © 8 | Hormel Foods [15304]
El kB
Tasks Title: - Home Address
> [ Dashboard Organization Haormel Foods
> @ Organization iddl No Address
e (opt)

» & Calendar/Tasks
b % Canvassing Last Name (opt) -
4 By contact Fmor Last tlame Work Address

% E:;tacts Mickname (opt) g%{jwwmw

r2sses ..
@ Househalds Contact Type: [Culpuratiun v] Eden Prairie. MN 55344

EH Contact Relationships
4 By Contributions/Pledges
@y Contributions
iy Contribution &llocations
@ Contribution Matches
iy Contribution Motifications
E Pledges
[cJ Pledges, Detail
[=] Thank You Letter - Contributions
» [ Reports
5 % Product Sales
b > Logs
i 5y Communications
» B Finandal
» g System Manager

Cpen Windows

] W O A
[ start Page

4 @ Contribution Match List
EH Hormel Foods

| General | Household | Gallery | Attribute | Foll

| Relation | Cortribute | Pledge | Event | Logs | Sales | Admin |

&R Mew | Refresh |@Surt @ Format - Eme |Ea Export & Print |@ Pivot |

CNINnouxio eCora Toundc

Amount De-
Open ] Date Amount Refunds After Cycle ]ESEM Event :I'Ia:iT:}l::lt pos-
Refunds ited
Ry [l
1 50.00 .00 50.00 o
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The final step will be to double-click in the green cell for Amount Received, enter the amount that the matching donor gave, and [Save] as you go.
My example is below where | recorded the full $50 amount for Hormel Foods.
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<3 Search W, Reset | 4 New == File - Edit - | ) | Contribution Match List
Q

| Favortes | General | [Match] Contact | Contibution | SQL |

)

Amount Expected:  minimum » to maximum -
[¥] Unpaid

1. Double-click in the green cell
and enter the ‘Amount Received'.

4 I
S8 Edit | Sort B Format - 53 Wrap | 5% Export ¢ Print | B Pivot
Contribution Match List [ 74 records found ]

[Match] Donor Contribution Amount

- -
ID ¥ ot hame [Match] Danor First Name Date B eciE

Mame M:

nite ay - =mith Ba
98 United W 12/5/2016 100,00 00 || Smith E
ardware Han
Hardware Hank 12/5/2016
- b i] £
wacl Jar
8/7/2015 00 || Zwack J
orporation for Mational And Community Service ! urton Jat
a4 C tion for Mati | And C ity Servi 6/7/2012 695,00 00 || Burt J
92 Hardware Hank 6,/4/2012 200.00 00| Walters Ju
a0 Corporation for Mational And Community Service 5/21,/2012 550.211 00 || Culloton M:
89 United Way 5/17/2012 650.00 00 || Hemshrot M:
88 Welcome Trust 5/14,/2012 400.00 00 || Eisenberg Be
87 United Way 5/3/2012 1,000.00 00 || Hemshrot M:
pits) Hardware Hank 5/2/2012 75.00 .00 || Wambach Dc
85 Corporation for Mational And Community Service 5/2/2012 500.00 .00 || Addington Eri
s
B 7 | || ||| 56,699.69 1,500.00 ||
< | m ] 3
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Click [Search] as you go and the results count will drop as matching gifts are fulfilled.
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Click [Search] to refresh the results and the results count will drop as matching
gifts are fulfilled.

., Reset | < New = = File - Edit - | ) | Contribution Match List

| Favorites | General | [Match] Contact | Contribution | SQL |

Amount Expected:
Unpaid

minimum + to maximum -

4 I

Sk Edit | Sort [ Format ~ S3Wrap | &% Export & Print | B Pivot |

Contribution Match List [ 71 records found ]

A1 _ | T T

D~ ftName . Match] DonorFirst Name bate " Dpedsd  Recewed Name N
95 I United Way 12/5/2016 100.00 .00 [ Smith o=
97 Hardware Hank 12/5/2016 50.00 00 || Smith Bo
g5 Cargill 8/7/2015 90.00 00 || Zwack lar
a4 Corporation for National And Community Service 6,/7/2012 695,00 00 || Burton Jar
92 Hardware Hank a/4/2012 200,00 00 || Walters Ju
a0 Corporation for Mational And Community Service 5/21/2012 550.21 .00 || Culloton M
&8 Welcome Trust 5/14/2012 400,00 00 || Eisenberg Be
&7 United Way 5/3/2012 1,000.00 .00 || Hemshrot [H
85 Corporation for National And Community Service 5/2/2012 500.00 00 || Addington Eri
&3 Caraill 4/11/2012 1,400.00 00| Boy ca 31
82 Corporation for National And Community Service 4/9/2012 500.00 .00 || Hockaday Jar
81 Caragill 4/5/2012 19.98 00 || Latsch Mi _
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The related resources below link to a variety of articles and videos similar to this topic.

999

g

Trail Blazer

- YouTube Channel
- Knowledge Base Articles
- 3rd Party Resources
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Related Resources

Article: How to Track Soft Credits using Contribution Notifications — ONLY for Nonprofit Customers
Article: Recording Non-Monetary (In-Kind) Contributions and Creating New Non-Monetary Types

Article: Enter Contributions

Article: Entering Pledges and Applying Payments to Outstanding Pledges
Article: Tax Deductible Contributions — How to Record the Tax-Deductible Amount and How to Mass Update a List of Contributions with a Tax-

Deductible Percentage

Article: How to Remove an ‘Event’ from the Drop-Down List when Entering Donations
Video: Getting Started 103 — Adding a Contact Record

Video: Getting Started 106a — Entering Contributions (NON PROFIT ONLY)

Video: Write Letter — Edit Letter after Mail Merge

Video: Getting Started 107 — Writing Contribution Thank You Letters

Video: Year End Tax Letter

Trail Blazer Live Support

© Phone: 1-866-909-8700
® Email: support@trailblz.com
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E? Facebook: https://www.facebook.com/pages/Trail-Blazer-Software/64872951180
B Twitter: https://twitter.com/trailblazersoft

* As a policy we require that you have taken our intro training class before calling or emailing our live support team.

Click here to view our calendar for upcoming classes and events. Feel free to sign up other members on your team for the same training.

* After registering you’ll receive a confirmation email with the instructions for how to log into the GoToMeeting session where we host our live
interactive trainings.

* This service is included in your contract.
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